Documentation Library Application (DLA)
Version 2.0.0.2, User Guide

Natella Feinstein
Charles Jackson
Carrie Brown
Gerry Pang

Naval Health Research Center

Technical Document No. 13-6F

Approved for public release; distribution is unlimited.

Naval Health Research Center
140 Sylvester Road
San Diego, California 92106-3521
Documentation Library Application
(DLA)
Version 2.0.0.1
User Guide

Natella Feinstein
Charles Jackson
Carrie Brown
Gerry Pang

Naval Health Research Center
Department 161
140 Sylvester Rd.
San Diego, CA 92106-3521

This project is supported by the U.S. Navy Bureau of Medicine and Surgery under Work Unit No. N1214. The views expressed in this work are those of the authors and do not reflect the official policy or position of the Department of the Navy, Department of Defense, or the U.S. Government. Approved for public release; distribution is unlimited.
# Revision History

<table>
<thead>
<tr>
<th>Release No.</th>
<th>Date</th>
<th>Revision Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0.0.0</td>
<td>June 2012</td>
<td>First draft, by Natella Feinstein.</td>
</tr>
<tr>
<td>1.0.0.0</td>
<td>Oct 2012</td>
<td>Addition of Reporting section, new importing instructions and screen shots, etc.</td>
</tr>
<tr>
<td>2.0.0.0</td>
<td>Nov 2012</td>
<td>Revisions</td>
</tr>
<tr>
<td>2.0.0.1</td>
<td>Apr 2013</td>
<td>Revisions</td>
</tr>
</tbody>
</table>
# Table of Contents

Introduction ..................................................................................................................................... 5  
Purpose ........................................................................................................................................ 5  
Points of Contact ......................................................................................................................... 5  
Application Overview ..................................................................................................................... 6  
Supported User Roles .................................................................................................................. 6  
Application Functionality ............................................................................................................ 7  
Installation Instructions ................................................................................................................... 8  
Getting Started—Guest Users ....................................................................................................... 10  
  Search for a Document in the Library ....................................................................................... 10  
    Simple Search ........................................................................................................................ 11  
    Advanced Search ................................................................................................................... 11  
  View Metadata as Read Only .................................................................................................... 12  
  Exporting and Reporting ........................................................................................................... 13  
Librarian User Role Tasks ............................................................................................................ 15  
  Import a New Document ........................................................................................................... 15  
  Import Metadata Only ............................................................................................................... 17  
  Add a Document to a Metadata Entry That Had No Associated Document ......................... 19  
  Open a Selected Document ....................................................................................................... 20  
  Delete Selected Document or Metadata .................................................................................... 21  
  View Metadata .......................................................................................................................... 21  
  Edit Metadata ............................................................................................................................ 22  
  Search for a Document in the Library ....................................................................................... 24  
    Simple Search ........................................................................................................................ 24  
    Advanced Search ................................................................................................................... 25  
  Exporting and Reporting ........................................................................................................... 26  
  Check Out and Edit an Imported Document ............................................................................. 26  
  Check a Document Back In ....................................................................................................... 27  
Appendix A Back End Implementation ........................................................................................ 29  
Appendix B Database Diagram .................................................................................................... 30
Introduction

The Department 161 Operational Research Support: Information Technology & Information Management team developed the Documentation Library Application (DLA) to organize and store department documentation in a secure and easily searchable and retrievable environment. Previously, documentation had been scattered throughout various locations. In spite of efforts to better organize information and make documentation easier to locate and reference, the search capability remained ineffective and time consuming. Also, the files were able to be moved and altered by anyone. This made a department “research library” capability limited. To correct this deficiency, Natella Feinstein developed the DLA. Now the department has a document retrieval capability that is secure and easy to manage. It cuts document search times dramatically, while it provides a single location for department researchers to locate any department documentation.

Purpose

The purpose of this document is to: (a) give an overview of the DLA concept, design, and implementation; (b) identify the operational environment; (c) provide DLA installation instructions; and (d) provide systematic instructions for using the application.

Points of Contact

<table>
<thead>
<tr>
<th>UR Support Team</th>
<th>Phone number</th>
<th>E-mail address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Natella Feinstein*</td>
<td>619-553-8033</td>
<td><a href="mailto:natella.feinstein@med.navy.mil">natella.feinstein@med.navy.mil</a></td>
</tr>
<tr>
<td>Gerald Pang</td>
<td>619-553-8409</td>
<td><a href="mailto:gerry.pang@med.navy.mil">gerry.pang@med.navy.mil</a></td>
</tr>
<tr>
<td>Carrie Brown</td>
<td>619-553-6314</td>
<td><a href="mailto:carrie.brown@med.navy.mil">carrie.brown@med.navy.mil</a></td>
</tr>
<tr>
<td>Charles Jackson</td>
<td>619-553-6572</td>
<td><a href="mailto:charles.jackson1@med.navy.mil">charles.jackson1@med.navy.mil</a></td>
</tr>
<tr>
<td>Lisa O’Mara</td>
<td>619-767-4325</td>
<td><a href="mailto:lisa.omara@med.navy.mil">lisa.omara@med.navy.mil</a></td>
</tr>
<tr>
<td>Michael Galarneau</td>
<td>619-553-8411</td>
<td><a href="mailto:michael.galarneau@med.navy.mil">michael.galarneau@med.navy.mil</a></td>
</tr>
</tbody>
</table>

*Documentation library administrator
**Application Overview**

The DLA allows the creation and support of a central library (repository) for Naval Health Research Center (NHRC) Dept 161 documentation and the metadata associated with each document (e.g., document title, type, authors, reference, year, and abstract). Documentation can be stored in Microsoft Office and Adobe PDF formats. The DLA graphical user interface allows you to quickly and easily find and access any document stored in the library. In addition, the DLA back-end is on Microsoft SQL Server 2005. This prevents loss of important department documents and provides security for stored documentation. The DLA is supported by a simple, easy-to-use interface.

---

**Supported User Roles**

The DLA is a role-based application and supports these user roles and operational privileges:

<table>
<thead>
<tr>
<th>User role</th>
<th>Operational privileges</th>
</tr>
</thead>
</table>
| Librarian | • Import documents into the library  
            • Import/modify/view document metadata  
            • Check out/check in documents for modification  
            • Delete documents from the library  
            • Search documents within the library  
            • Export hyperlinked document lists, including a jmpt research initiatives list |
| Guest    | • Search for documents within the library  
            • View document/metadata as read only  
            • Export hyperlinked document lists, including a JMPT research initiatives list |
Application Functionality

The DLA allows a librarian to import, export, edit, or delete DLA content. A guest may search, view, and export DLA contents. The following menu options are available according to your assigned role.
Installation Instructions

The DLA minimum application requirements are Windows XP and access to the DLA SQL Server database.

To install the DLA, navigate to N:\Dept 161\3 - PRODUCTS\Software Installation\DocumentationLibrary. There are three steps, shown below.

1) To start the installation process, double click the Install_DocumentationLibrary.bat file. The application will begin its automatic installation.

2) The Windows command prompt appears, and then the Security Warning window immediately overlays it. Click the Install button.

3) To close the command prompt window, press any key. DO NOT close this window by clicking the × in the upper right corner of the window.
4) To verify that the installation was successful, scan the desktop for the DLA icon. Next, check that the application appears in the Start menu Programs List. Click the Start menu button in the Task Bar of your screen, select Programs, and then Naval Health Research Center. You should see the DLA menu item listed under the NHRC programs there. Contact the DLA software POC if you encounter any application installation problems (see page 4 for contact information).

If you do not have access to the SQL server DLA repository, the program will display the following message:

![Database Access Error Message]

Contact the DLA software POC (see page 4) for help accessing the DLA database.
Getting Started—Guest Users
You can launch the DLA either by clicking the icon on your desktop, or by navigating to the item in the programs list. When you launch the DLA, the initial view is shown below:

Click any of the book icons to view general or specific document lists. Guest users have access to all the documentation, but are not able to modify the library and its contents. Guest users are able to:

- search for documents within the library using the search feature,
- view and print most documents contained in the library,
- view metadata as read only,
- and export hyperlinked document lists to Excel.

Search for a Document in the Library
The DLA provides two methods to search for documents: a simple search, and an advanced search. The following subsections describe each method.
Simple Search
To start a simple document search:

1. Specify a search field (element) from the drop down box in the top right corner of the view.

2. Then type a search term in the text box below the search field. Search terms are not case sensitive.

3. Begin the search by clicking the right arrow (start search) button labeled above. The program will search for all documents that meet the entered search criteria. If you are not sure what search field to use, you may search by All fields. In that case, the program will search for documents that contain an entered text in any of the metadata elements. For example, if you specified a search field as All, and the search term “test,” the program will search the metadata for documents associated with the word “test” either in the document name or the document type or the authors list or the document title, and so on, through all metadata elements. The search results will be displayed in the work pane as shown here. (“Or” means if search term is at least in one of those categories then the document will be included in the search result.)

Advanced Search
The Advanced Search enables you to better define or narrow your search criteria. You can set one or more search elements. To perform an advanced search:
1. Click **Advanced Search** in the menu bar. The advanced search screen will appear as shown below:

![Advanced Search Screen]

2. Fill the field(s) of interest with your search term(s) (search terms are not case sensitive).

3. Then click the **Search** button. An example of this would be that you would like to find all journal articles by MacGregor published in 2010. You select the **Advanced Search** option, choose “Journal Article” as the **Type**, enter “MacGregor” in the **Authors** field, and “2010” in the **Year** field. When you click **Search**, the program will return documents which contain the **Type** as “Journal Article” and the **Authors** as “MacGregor,” and the **Year** as “2010.” The search result may look like this (below). (“And” means that the document will be included in the search results only if all of the categories contain the search term.)

![Search Result]

4. Click the **Back** button and return to the main documentation screen to refine/modify your search.

### View Metadata as Read Only

To view the metadata of a particular document:
1. Select (highlight) the document.

2. Click View, View Metadata, or right click on the work pane to select View Metadata from the quick access menu.

The metadata window will overlay the DLA view as a read-only display.

Exporting and Reporting

Reporting refers to the DLA functionality that allows you to export lists of selected contents to a Microsoft Excel file. These lists will reside on your computer or in a specified location. The lists may contain hyperlinks to the documents they reference and can serve as shortcuts as long as the file can link to the DLA. This is a way that the DLA can help you manage your references.
After you have used the search features and developed a list of documents that you are interested in, go to the menu bar and select **Reporting**. The following two options are displayed.

Selecting **Export All Displayed Documents to Excel** will build an Excel file of all documents displayed in the work pane. Selecting **Export Selected Documents Only to Excel** will build an Excel file that only contains the documents that you have selected by highlighting them. To do this, hold down the SHIFT key to select blocks, or the CTRL key to select multiple separate, line items in the work pane. Name and **Save** the Excel export to the location of your choice.
Librarian User Role Tasks
This section describes Librarian user role tasks within the DLA. If you are designated as a librarian, you maintain the DLA.

Import a New Document
To import a new document, follow these steps:

1. Select **Import New Document**, either through the **File** drop-down menu or by right clicking anywhere on the list of displayed documents in the work pane, to reveal the right click menu.

2. The **Select a document to be imported** window appears. Navigate to the document that you want to import, click the file to select it, and then click the **Open** button.
3. When you click the **Open** button, the program checks if a document with the same file name already resides in the library. If the selected document file name is new, an empty metadata entry form appears. Some elements have a pick list; the required elements are annotated with a red asterisk. Enter all available metadata elements. The document **Type** chosen determines which category the file will be listed under (e.g., IRB, Proposal).

4. Click **Save**.
   If the selected document file name already resides in the DLA, the program will display the message shown here, which gives you three options to choose from.
5. Once you chose either **YES** (overwrite) or **NO** (import as a new version), the program will display the metadata screen of the existing document for your review/update. If you selected **YES**, the program will overwrite the existing database document and its metadata and you must enter new metadata. If you selected **NO**, the new version of the document will be imported into the database, the version number will increase by one, and you must enter new metadata.

![Overwrite Existing Document](image)

6. Enter or edit metadata as needed, and then click the **Save** button. The new or replaced version of the document will then appear in the document list.

![Documentation Library](image)

**Import Metadata Only**

Sometimes a document is not available for upload into the DLA but metadata for the document is available. You can enter the metadata as documentation until a copy of the document is on hand. To do this:

1. Go either to the **File** menu or right click anywhere on the list of displayed documents to view the menu and choose **Import Metadata Only**.
2. On the metadata form, enter as many elements as you can.

3. Click **Save**. The program saves the metadata with “n/a” (not available) as the **File Name**, zero as the **Version**, and the document **Title** as entered (shown as “Test metadata only”).
Add a Document to a Metadata Entry That Had No Associated Document

To add a document to a document-less metadata entry:

1. Select the line item in the displayed list (Document Name will be “n/a”), and then either click the File menu or right click anywhere on the list of displayed documents to select the Add Document to Metadata option.

   ![Image of a user interface showing the process of adding a document to metadata]

   The program will prompt you to locate and select the document to be imported.

2. Navigate to the document.

3. Select it, then click Open. The program will check for a duplicate file name. Since there is not one to find, the document will load and be associated with the selected metadata.
Open a Selected Document

To open a document within the DLA:

1. First you locate it within the list; click on it to highlight (select) the document.

2. Then either:

   a. use the File menu to select Open Selected Document,

   b. right click in the work pane for the quick access menu and select Open Selected Document from there, or

   c. double-click the line item. The selected file will open.

If you do not close a file after viewing it and you try to open it again, the program will inform you that a selected file is already open with the following Windows alert.
Delete Selected Document or Metadata

To delete a document or set of documents stored in the DLA:

1. Select (highlight) a document to be deleted (you may select several at one time).

2. Then either:
   a. click the **Delete Selected Document/Metadata** menu item (either from the **File** menu),
   b. right click in the work pane for the quick access menu and select **Delete Selected Document/Metadata** from there, or
   c. simply select DELETE from your keyboard. A Confirm Document Deletion window will give you an **OK** or **Cancel** option. Select **OK** and the selected file will be deleted.

View Metadata

To view the metadata of a particular document:

3. Select (highlight) the document.

4. Click **View**, **View Metadata**, or right click on the work pane to select **View Metadata** from the quick access menu.
The metadata window will overlay the DLA view as a read-only display.

**Edit Metadata**

To edit the metadata of a particular document:

1. Select (highlight) the document.
2. Open the edit metadata capability by either:
   a. clicking the **Edit, Edit Metadata** option from the menu bar, or by
   b. right clicking on the work pane to select **View Metadata** from the quick access menu.
3. The next screen displays the selected document’s existing metadata. Make all necessary changes or additions and then click the **Save** button to store the modified metadata for the corresponding document in the DLA.
Search for a Document in the Library

The DLA provides two methods to search for documents: a simple search, and an advanced search. The following subsections describe each method.

Simple Search

To start a simple document search:

4. Specify a search field (element) from the drop down box in the top right corner of the view.

5. Then type a search term in the text box below the search field. Search terms are not case sensitive.

6. Begin the search by clicking the right arrow (start search) button labeled above. The program will search for all documents that meet the entered search criteria. If you are not sure what search field to use, you may search by All fields. In that case, the program will search for documents that contain an entered text in any of the metadata elements. For example, if you specified a search field as All, and the search term “test,” the program will search the metadata for documents associated with the word “test” either in the document name or the document type or the authors list or the document title, and so on, through all metadata elements. The search results will be displayed in the work pane as shown here. (“Or” means if search term is at least in one of those categories then the document will be included in the search result.)
Advanced Search

The Advanced Search enables you to better define or narrow your search criteria. You can set one or more search elements. To perform an advanced search:

5. Click **Advanced Search** in the menu bar. The advanced search screen will appear as shown below:

![Advanced Search Screen](image)

6. Fill the field(s) of interest with your search term(s) (search terms are not case sensitive).

7. Then click the **Search** button. An example of this would be that you would like to find all journal articles by MacGregor published in 2010. You select the **Advanced Search** option, choose “Journal Article” as the **Type**, enter “MacGregor” in the **Authors** field, and “2010” in the **Year** field. When you click **Search**, the program will return documents which contain the **Type** as “Journal Article” and the **Authors** as “MacGregor,” and the **Year** as “2010.” The search result may look like this (below). (“And” means that the document will be included in the search results only if all of the categories contain the search term.)

![Search Result](image)

8. Click the **Back** button and return to the main documentation screen to refine/modify your search.
Exporting and Reporting

Reporting refers to the DLA functionality that allows you to export lists of selected contents to a Microsoft Excel file. These lists will reside on your computer or in a specified location. The lists may contain hyperlinks to the documents they reference and can serve as shortcuts as long as the file can link to the DLA. This is a way that the DLA can help you manage your references.

After you have used the search features and developed a list of documents that you are interested in, go to the menu bar and select **Reporting**. The following two options are displayed.

Selecting **Export All Displayed Documents to Excel** will build an Excel file of all documents displayed in the work pane. Selecting **Export Selected Documents Only to Excel** will build an Excel file that only contains the documents that you have selected by highlighting them. To do this, hold down the SHIFT key to select blocks, or the CTRL key to select multiple separate, line items in the work pane. Name and **Save** the Excel export to the location of your choice.

Check Out and Edit an Imported Document

Documents in the DLA can be modified by the user, and then resaved. The original document can be overwritten, and thus replaced, or the user can choose to update a document and save it as a new version, thereby maintaining the original version. By this method, collaborative writing with version control is possible.

1. Open the DLA and locate the document that you want to modify. Highlight the line item and then go to the **Edit** menu to select **Check-Out Document**.

2. When the document appears, make your changes and simply click **Save** from the program menu bar above the open document. (Note: Do not select **Save As** or alter the original file name.) The document will be saved in a folder on your L:Drive where checked-out versions are stored temporarily. The document will not be saved to the DLA until you check the document back in. (Note: Some document types may not be editable, such as early versions of PDF documents.)

3. To view checked-out documents, select **View** from the menu bar and **View Checked-Out Documents** from the dropdown menu.
Check a Document Back In

There are two ways to check a document back into the DLA. The first method is to **overwrite** the existing document with a modified document that you have checked-out, altered, saved, and have waiting in your L:Drive holding folder. When you overwrite, the old document in the DLA is replaced with the modified copy; the old document will be deleted and cannot be retrieved.

To replace an existing document with a new version:

1. From the menu bar, select **View, View Checked-Out Documents**.
2. Highlight the item (in the line list) that you want to check-in.
3. Select **Edit, Check-In changes made to the selected document**.
4. In the **Check-In** window below, select **Overwrite**.

The second method is to check the document in as a **New** document (i.e., a new version). By this method, the DLA automatically adds the modified version of the document and updates the version number in the metadata. Afterwards there will be more than one version of the same document with the same file name, but each will have a unique version number. The higher version number indicates the most recent version.
If copies have been checked-out and they are no longer needed and will not be used, they can simply be deleted. To do this:

1. From the menu bar, select **View, View Checked-Out Documents**.

2. Highlight the item in the line list that you want to check-in.

3. Go to **Edit**, in the menu bar, and select **Check-In changes made to the selected document**. The document will be deleted from the temporary holding folder in your L:Drive. The original document remains intact in the DLA.

4. In the **Check-In** window below, select **New**. The document is re-entered into the library with a new version number.
Appendix A
Back End Implementation

The DLA interface is based on the SQL Server 2005 back end, which provides DL application functionality.

The DLA back end is based on the DL SQL server database that contains the following tables:
Appendix B
Database Diagram

DLA dm in

SQL server table to support user’s roles.

SortElements

SearchWhere

Tables to support “sort” & “search” functionality

Tables to support document’s metadata
**ABSTRACT**

The Naval Health Research Center’s (NHRC) Department 161 developed the Documentation Library Application (DLA) to organize and store department documentation in a secure, easily-searchable, and retrievable environment. Previously, documentation had been scattered throughout various locations—also, files were able to be moved and altered by anyone. This made a department “research library” capability limited. Now the department has a document retrieval capability that is secure, is easy to manage, cuts document search time, and provides a single location for staff to hold documentation. The purpose of this user guide is to: (a) give an overview of the DLA concept, design, and implementation; (b) identify the operational environment; (c) provide DLA installation instructions; and (d) provide systematic instructions for using the application.